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Introduction 

InScribe is a HIPAA-compliant typing application designed by transcriptionists for transcriptionists.  

InScribe is a single, integrated application with sections (demographics, body, cc, signatures, comments, etc.), designed 

for heads down production. You have everything at your fingertips — demographics, referring physician information, 

AutoText (word expander), spell check — and can easily and quickly complete a quality document. Over the course of 

many years InScribe has grown into a tool that helps you produce a higher number of lines than with traditional word 

processing applications, which is essential when you are paid on a per-line basis. You are no longer required to perform 

research, print transcriptions, cover letters or envelopes. Since transcriptionists are paid by the number of lines produced, 

this software was designed to allow you to be in production mode most of the time. 

New features and functionality introduced in InScribe 7 will be added to this user manual in 

the coming months. Please check back for an updated version soon. 

Highlights of InScribe include: 
Demographics 

Demographic information (patient name, MRN, etc.) in many cases is imported using an interface with the hospital. When 

you input the unique patient MRN or name, the system automatically searches for and presents you with matches. When 

the patient is selected, the system displays the corresponding appointment dates and imports all available demographics. 

Referring Clinician Information 

Primary care physicians, attending physicians and other individuals can be designated to receive copies of a transcription 

electronically, via auto-fax, or by standard mail. You have access to an online database of referring clinicians to easily 

assign recipients per the dictation. No time is wasted researching names and addresses.  

Body of Document 

The body of an InScribe document is built from templates (dictation or document), AutoText (word expander), and free 

hand typing. Document templates automatically load into the body of the transcription based upon a combination of 

author, document type, and location. Dictation templates are retrieved from the server based upon what an author dictates 

(e.g. “normal left wrist”). No time is wasted finding the proper template. 

Authorizations 

When transcriptions require approval by more than one clinician, InScribe’s online database of dictating clinicians makes it 

easy for you to select the appropriate clinician and assign the order of authorization.  

A Note on Hot Keys 

The hotkeys displayed in red are the default hotkeys assigned when 

InScribe is first installed.  They are known as the “Modified Shortcuts.” 

There are two other configurations available called “Classic Shortcuts” 

and “ASR Enhanced Shortcuts.”  
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Requirements 

For eScription One InScribe software to work properly within a Windows environment, your system must meet the 

following software and hardware requirements:  

(Macintosh computers are NOT supported by eScription One.) 

Minimum Requirements: 

– Operating System: Windows 8.1 

Note: Windows 98, 2000, NT4, XP, Vista, and Windows 7 users - eScription One does not support any versions of 

Windows prior to Windows 8.1, please upgrade Windows before calling. 

– RAM: 4 GB 

– Processor: 1 GHz or faster (32- or 64-bit Architecture) 

– Hard Drive Free Space: 1 GB 

– .NET Framework: 4.7.2 or higher 

– Sound Card with Speakers (or Stereo Headphones) 

– Web Browser: Windows Internet Explorer 11, Chrome 

– Monitor Resolution: A monitor capable of displaying a resolution of 1366 x 768 pixels 

– Internet Connection: High Speed Cable or DSL 

– Internet Bandwidth: 3 Mbps download; 1 Mbps upload or greater 

– Communicates over port 443 to https://transcription.escription-one.com using TLS 1.2 

Recommended Requirements: 

– Operating System: Windows 10 

– RAM: 8 GB or more 

– Processor: 1 GHz or faster (32- or 64-bit Architecture) 

– Hard Drive Free Space: 2 GB or more 

– .NET Framework: 4.7.2 or higher 

– Sound Card with Speakers (or Stereo Headphones) 

– Web Browser: Windows Internet Explorer 11  

– Monitor Resolution: A monitor capable of displaying a resolution of 1366 x 768 pixels or higher 

– Internet Connection: High Speed Cable or DSL 

– Internet Bandwidth: 3 Mbps download; 1 Mbps upload or greater 

– Communicates over port 443 to https://transcription.escription-one.com using TLS 1.2  
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Installing InScribe 

Note: Users working on a domain network may need administrator privileges to install eScription One or any other 

programs. 

Download the InScribe application from the eScription One Software page here: https://www.escription-

one.com/Software/InScribe. Select the version of InScribe you would like to install by clicking the Install Link. 

Note: Contact the transcription company manager to verify which version to install. 

– Select “Open” or “Run”. 

– The “What’s New” screen provides a summary of changes in prior versions and recently added bug fixes, features, or 

improvements. 

– Select “Continue”. 

– Click next to begin the installation process. 

– Select an installation folder.  eScription One recommends using the default location. Click “Next” to advance to the next 

window, to confirm this file path. Click “Next” to complete the installation. 

– Select “Close” on the two following screens. The installation is now complete. 

Using InScribe 

Note: Obtain a username and password from the transcription company's system administrator prior to logging into 

InScribe. 

Start the InScribe program by using the shortcut created on your desktop. 

An additional short cut is located under the “Start” Menu. 

Click on the “Windows” icon, then scroll to the “InScribe 7” folder. Click to 

expand the folder and click “InScribe 7”. 

  

https://www.escription-one.com/Software/InScribe
https://www.escription-one.com/Software/InScribe
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The “eScription One InScribe” login window opens. The following 

options appear at the bottom of the screen: 

– Download Dictations on sign In: Enable this option to download 

dictations automatically upon login. 

– Sign in with Training Mode: Log into Training Mode to access the 

training files.  

Note: To see the ‘Sign in with Training Mode’ option, you must select 

‘View Training Materials’ during installation and download the InScribe 

training files, or you can download them from the software site: 

https://www.escription-one.com/Software/InScribe. 

 

 

 

 

Initial Login 

To log in for the first time, click the New Login button at the bottom of the screen. 

The login credentials screen opens. 

Enter your Username, Password, and Company, then click Log In.  

– Username:  Login credential to identify a transcriptionist.  

– Password:  Authenticating word or passphrase for secure login.  

– Company:  Abbreviation or Acronym identifying the transcription 

company. 

The Forgot Password? link allows users who have saved a valid email 

address to receive password reset instructions by email if it is lost or 

forgotten. 

  

https://www.escription-one.com/Software/InScribe
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Logging in after the First Time 

The next time you log in, your saved login credentials appear 

on the login screen, along with the date and time of your last 

login. Your saved credentials include your Username and 

Company name. InScribe does not save passwords. 

 

 

 

 

 

Click the saved credentials icon. 

 

 

The login screen opens, with the credentials filled in. 

Just enter your password and click Log In. 

Note: The pre-filled fields are read-only. To log in with a 

different Username and/or Company, click Cancel to 

return to the login screen and choose New Login. 

InScribe saves each set of credentials you use to log in. 

The most recent login appears at the top of the list.  

If you want to remove a saved login from the screen, for 

example, if you are a manager or if you 

perform QA, and you will not need to log into 

this account again, click the stop sign icon. 

The credentials will be removed from the 

screen. 
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The initial InScribe Screen: 

 

Download Dictations 

Downloading Dictations:  Upon logging into InScribe, a request for dictations is made to the eScription One Server. This 

option can be disabled by unchecking the option “Get Dictations on Login” on the login screen or in File > Options > 

General > Startup Options.  If this option is disabled press “Next” (Hotkey: F12) to start downloading jobs. A status bar 

appears to track the download process in the bottom left hand corner. Once the first file has been completely downloaded, 

transcription work can be started with future downloads occurring in the background. 

Downloaded dictations appear at the top of the screen.  By default, the maximum number of dictations is three. 
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Function Keys 

Function Key:  Downloading a transcription will enable the Function keys arranged at the top of InScribe.  It is important 

to note that you have the opportunity to customize the function key actions. (File > Options > Shortcut Keys)  The options 

below are the defaults and are the most commonly used functions. 

 

 

< F1 > Next Field: Skip to the Next [Field] within the transcription. 

< F2 > Play:  Play and Pause the dictation playback. 

< F3 > Rewind: Rewinds the dictation playback. 

< F4 > Fast Forward: Fast Forward the dictation playback. 

< F5 > Add Associate:  Add a carbon copy recipient. 

< F6 > Copy Transcription:  In the event that several patient dictations are dictated in one recording, copy the selected 

dictation and transcription text to a new transcription to transcribe the additional report. 

< F7 > Complete:  Mark the selected transcription as “Done” or “Completed.” 

< F8 > Mark for Review:  Mark the selected transcription as "Marked for Review." 

< F9 > Save:  Save the selected transcription. 

< F10 > AutoText:   Create macros and text expansions. 

< F11 > Show Pool: Display work currently available for transcription. 

< F12 > Next:  Advance to the next dictation, download new files if available, and upload completed work. 
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Info Pane 

Demographic Information:  Patient demographic information is located on the left 

side of the InScribe screen. Depending on the dictation device used by the author, 

demographic information may auto populate when downloading the audio file.  

When demographic information is not automatically available, search for a patient 

using the Patient ID and Patient Name fields.  To search by Patient ID enter the 

exact number and press “Tab.”  To search by patient name enter the entire, or any 

part of, the patient’s name and press “Tab.” 

If appointment information isn’t available, information can be entered manually. 

If the Patient has multiple appointments, the “Appointment Listing” window will 

appear. Choose the appropriate appointment for the dictation, based on the 

dictating physician and the date.  Use the arrow keys and “Enter” or the mouse to 

select the appointment. 

 

 

 

 

Info Pane Functions 

Patient Name Search:  If the Patient ID dictated does not match the name dictated, 

find the patient with a Name Search. To look up a patient name press the “Patient 

Name Search” icon. (Hotkey: Ctrl+F) 

 

The “Patient Search” window will appear.  Search by Last Name, First Name, and 

Date of Birth.  The search function is capable of searching for partial names.  For example, searching for “and” in the last 

name field will return results for “Anderson” and “Sanderson.” 

Patient ID Search: Search the patient database by ID for available Appointments.  (Hotkey: Ctrl+N) 
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Appointment Search:  Search the patient database for available Appointments based on the Patient ID in the 

demographics 

Clinician Appointment Listing:  Search for all appointments by Clinician and Appointment Date based on the 

Appointment Date and Clinician selected in the demographics.  (Hotkey: Ctrl+Shift+L) 

Edit Patient:  Edit patient Demographic and Contact information.  (Hotkey: Ctrl+Alt+E) 

List Document Types by Description:  Toggle between the short name and the long description in the Document Type 

drop-down list.  (Hotkey: Ctrl+Alt+X) 

Print and Document Template Demographics 

Choosing the correct Clinician, Document Type, and Location are critical to generate a properly formatted document.  

These three demographics determine which template is loaded.  The print template, which includes any headers, footers, 

and letterhead will automatically update when a new combination of Clinician, Document Type, and Location is selected.  

The finished document is built by combining the print template with the document template and transcribed text.  

If the clinician, document type, and/or location change after the document template has been loaded, InScribe users will 

need to decide what to do with the existing transcription in the main editing window.  If the new combination has no 

document template associated with it, existing transcription will remain. 

– Overwrite Transcription:  Delete all existing document template 

and any existing transcription.  Any existing text will be 

replaced by the new Document template. 

– Insert at Cursor:  Insert the new document template at the 

location of the cursor. 

– Keep Text:  Keep the existing transcription without loading the 

new Document Template. 

 

 

Clinician 

Select from a list of possible dictators.  The clinician field typically populated with 

the dictators when a file is loaded into InScribe, but can be changed.  (Hotkey: 

Alt+R) 
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Document Types 

Choose from a list of possible document types available for the author. The 

author selects a document type during the dictation process. If an author 

selects the wrong document type, or does not choose one, a new document 

type can be selected from the list. The list of available document types will 

change based on the author. Once a document type is selected a Document 

Template will automatically load into the body of the transcription based on the 

combination of Author, Document Type, and Location.  (Hotkey: Alt+W) 

 

Location 

The location demographic can be used to specify a specific physical location 

(South Clinic) or a department or organizational division (Cardiology 

Department).  Most dictation methods allow or require the clinician to select a 

location.  (Hotkey: Alt+L) 

 

 

 

 

Carbon Copies 

Add CC:  When an author needs to send a copy of the transcription to another person, 

the recipients are called Associates and are added in the CCs panel. To search for an 

associate press “Add Associate” at the top of the screen or click on the Green “+”.  

(Hotkey: F5 or Ctrl+Alt+N) 

To initiate a search, some or all of either the Associate’s first or last name must be 

entered.  Additional information in the form of specialty, City, State, and Zip Code is 

optional. If you have a BenchMark KB subscription, you will also be able to search the 

national physician’s database. Click for more information: 

http://www.interfix.biz/kbemdat.aspx 

Press search to initiate a search. 

Select a name from the results to move onto the Associate Details window.   

  

http://www.interfix.biz/kbemdat.aspx
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– Primary Associate:  One Primary associate is allowed per Transcription.  This is 

the associate the document will be primarily addressed to.  It is possible to have a 

document without a primary associate. 

– Add Associate:  Add the new Associate to the database, or update an existing 

associate’s information.  This option must be enabled by the Transcription Company. 

– AutoFax:  AutoFax status can only be changed with the Add Associate box active.  

When AutoFax is active the associate will receive a fax via the eScription One 

AutoFax feature.  A valid 10 digit fax number must also be present. 

– PCP for Patient:  Add an associate as the Primary Care Provider.  The Primary 

Care Provider is automatically copied on any future transcriptions for the same 

patient. 

Delete CC:  Remove the selected associate from the CC list.  (Hotkey: Ctrl+D) 

Edit CC:  Open the Associate Details window for the selected associate.  (Hotkey: Ctrl+E) 

Insert To Whom It May Concern Associate:  Insert a generic “To Whom It May Concern” as the addressee.  

Make the Selected Associate the Primary Associate: Promote the selected associate to the status of the Primary 

Associate.  (Hotkey Ctrl+1) 

Create Associate From Patient:  Convert the Patient’s information into an associate entry.  (Hotkey Ctrl+2) 

Additional Authenticators 

Additional Authenticators are added when a document requires more than one physician’s signature on the document.  

This frequently occurs when resident physicians are being overseen by attending physicians, but additional authenticators 

are added in a variety of situations.  The drop-down list contains the all available dictating users for the Client. 

– To add an additional authenticator select a provider’s name from the drop-down list and press the button.  (Hotkey 

Ctrl+Alt+A)  Note that the authenticator has not been added simply by selecting the name.  The  button must be 

pressed to add the name to the transcription. 

– To remove an additional authenticator, select the provider’s name from the list and press the  button.  (Hotkey 

Ctrl+Alt+D) 

– Use the  and  buttons to Change the order in which the authenticators sign the document and the order in which the 

signatures appear on the transcription. 

Comments and Comment Tags 

Comments and Comment tags are used to communicate information that does not appear on the document itself.  

Comment Tags are canned responses to frequently occurring issues.  Healthcare providers researching documents can 

search and sort by comment tags in the InQuiry application.  Comments are used to communicate with either QA 

personnel or with the healthcare providers.  The transcription manager will have specific instructions on how to use the 

Comment and Comment tag features. 

– To add a comment tag, select one from the drop-down list and press the  button.  (Hotkey: Alt+[ ) 

– To remove a comment tag, select and existing comment tag and press the  button.  (Hotkey:  Alt+] ) 
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– To add comments, enter text into the available space. 

– Press the  button to erase all comment content. 

– Press the  button to display available discrete data. 

Discrete Data 

Some document templates define fields that are specifically named by your transcription company. This allows the text 

used to replace that field to be referenced by a field later in the document, or by an interface. The Discrete Data window 

allows you to see what fields have been identified and named, and what values have been associated with each field. 

Please note that this feature is rarely used. 

File Tab 

The File menu contains Options and Administrative options. 

– Save:  Save the contents of the Active Transcription.  This performs the same function as the 

 button in the top left corner.  (Hotkey: Ctrl+S) 

– Stop Downloads:  Stops the automatic download of new dictations.  The status of 

downloads is available in the top left corner.  (Hotkey: Ctrl+Alt+Z) 

–  Indicates dictations have not been blocked from downloading. 

–  Indicates dictations have been blocked from downloading. 

– Preview Transcription:  View the document as it would appear in InQuiry.  

o  Show/Hide Labels under the function buttons.  

o  Generate a Print Preview as if the document was printed. 

o Refresh the window to display any changes made.  Alterations can be 

made in InScribe while the preview window is open. 

o Close the Transcription Viewer. 

– Explore:  Explore the contents of the folders where the raw dictation and transcription files are stored.  The contents of 

this folder are primarily viewed when troubleshooting. 

– Backup Personal Files:  Create a backup of AutoText entries 

and words that have been added to the personal dictionary.  

The backup is placed in the “InScribe 6” folder of the 

computer’s “Documents.” 

– Restore Personal Files:  Restore AutoText and Personal 

dictionary entries from the backup location. 

– Options:  Customize InScribe behaviors and settings.  (See 

Section 3 for additional information on Options.) 

– Exit:  Exit and logout from the InScribe application. 
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Home Tab 

Dictation Playback 

The controls for dictation playback are located after the F12 icon on the HOME tab. The following controls are in this 

section:  

1. Play from beginning (Hotkey: Ctrl+Shift+Z) 

2. Rewind  (Hotkey: Ctrl+Shift+C) 

3. Play  (Hotkey: Ctrl+Shift+X) 

4. Pause  (Hotkey: Ctrl+Shift+Q) 

5. Forward  (Hotkey: Ctrl+Shift+V) 

6. Mark Index  (Hotkey: Ctrl+Shift+I) 

7. Jump to Index  (Hotkey: Ctrl+Shift+J) 

8. Clear Index  (Hotkey: Ctrl+Shift+K) 

9. Insert Time  (Hotkey: Ctrl+Shift+T) 

Speed and Playback Rate 

The Speed Control is a drop-down menu.  Adjust the rate of dictation in three different ways. 

– You can adjust the speed by clicking on Increase or Decrease Speed.  This will flip between 

Slowest, Slower, Slow, Normal, Fast, Faster or Fastest. 

– Keyboard Shortcut (Hotkey: Ctrl+Shift+< ) and (Hotkey: Ctrl+Shift+> ) 

– You can directly click on the speed desired.  To remember the playback rate by author, go into the 

File tab > Options > Playback and select this option. 

The Volume Control is also a drop-down menu and will display the volume setting.  Adjust the volume 

in two different ways.  Volume can also  be adjusted with the Windows Volume settings. 

– Click on the Louder or Softer to scroll through the percentages of total volume. 

– Click on the percentage.   

ShadowScribe Cursor Functions 

These features are only available during ShadowScribe or Voice Recognition jobs that have passed 

through the ASR engine for initial transcription. 

– Attach Selection:  Attach the Selection cursor to the Playback cursor.  (Hotkey: Ctrl+F12) 

– Move Playback to Cursor:  Adjust the playback time to match the cursor’s location in the Transcription.  

(Hotkey: Ctrl+Shift+F12) 
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Correction Playback 

Toggles between the retrieved dictation and the correction dictation when the “Retrieve & 

Correct” feature is used from Get Prior Transcriptions.  (Hotkey: Ctrl+Shift+R) 

 

 

Transcription Tab 

Transcription Tab buttons are Creation, Navigation, and Completion actions. 

 

– New:  Create a Transcription, or TID, without an audio file.  (Hotkey: Ctrl+Shift+N) 

– Copy:  Create a Transcription with some or all of the properties as the Active Dictation. 

o Copy Transcription:  Copy the Dictation Audio, Info Pane Demographics, Carbon Copies, Additional 

Authenticators, and the Transcription text of the selected Dictation to a new Transcription.  (Hotkey: 

Ctrl+Shift+Y) 

o Copy Dictation and Header:  Copy the Dictation Audio, Info Pane Demographics, Carbon Copies and 

Additional Authenticators.   

o Copy Dictation:  Copy the Dictation Audio File only.  (Hotkey: Ctrl+Alt+Y) 

o Split Transcription:  Copy the Dictation Audio, Info Pane Demographics, and the Transcription text after 

the cursor to a new Transcription.  (Hotkey: Ctrl+Alt+S) 

– Download Next:  Download the next dictation file from the server if the maximum allowed number of downloaded jobs 

has not been reached (this is set by the transcription company manager).  (Hotkey: F12) or (Hotkey: 

Ctrl+Shift+Return) 

– Move Up/Down:  Move between available downloaded dictation audio files.  (Hotkey: Ctrl+Alt+Up) and (Hotkey: 

Ctrl+Alt+Down) 

– Mark for QA:  Mark the transcription to be routed to the next QA level when available.  (Hotkey: Ctrl+Q) 

– Mark for Review:  Mark the transcription to be routed to the Client Review folder when available.  (Hotkey: Ctrl+W) 

– Lock:  Lock the transcription file to prevent accidental modification or completion.  (Hotkey: Ctrl+Alt+K) 

– Spell Check:  Manually initiate the spell check process.  (Hotkey: Ctrl+K) 

o Enable Spell Check as You Type:  Check this box to activate real time spell checking. 

o Complete:  Mark the Transcription as completed and ready to upload to the server.  (Hotkey: Ctrl+O) 
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o Repool:  Check the audio file back into the server and save any changes made to Author, Document Type, 

and Location.  (Hotkey: Ctrl+H) 

o Invalidate:  Mark the Transcription as invalid.  Invalid Transcriptions are removed from the standard 

workflow.  (Hotkey: Ctrl+J)  

o Upload:  Send all Transcriptions marked as complete to the server.  (Hotkey: Alt+U) 

Data Tab 

The Data Tab holds function buttons used to acquire information stored on the database for use during the transcription 

process. 

 

Templates 
– Document:  Download the Document Template for this Author, Document 

Type, and Location combination.   

(Hotkey: Ctrl+Shift+G) 
 

 

 

– Dictation:  Retrieve a list of available Dictation Templates, or Normals, 

available to be inserted at the cursor.   

(Hotkey: Ctrl+Alt+G) 
 

 

 

Fields 

– Next:  Jump to the next available [Field].  Fields are indicated by the square brackets and may or may not contain text.  

(Hotkey: Ctrl+G) 

– Clear Remaining:  Delete any unfilled transcription [Fields].  (Hotkey: Ctrl+[ ) 

 

Search 

– Patient:  Open the Patient Database search window. 

o By Number  (Hotkey: Ctrl+N) 
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o By Name  (Hotkey: Ctrl+F) 

– Appointment:  Open the Appointment search window. 

o By Patient  

o By Clinician  (Hotkey: Ctrl+Shift+L) 

– Transcription: 

o Prior:  Search for existing transcriptions based 

upon Patient, Clinician, and/or Document Type.  

From this window View Prior Transcriptions with or 

without the Template.  Use the Append to Prior 

button to append the active transcription to a 

previously typed document, or Remove Append 

to sever such a connection. 

(Hotkey: Shift+F1) 

o Find Existing:  Search the local backup directory for existing transcriptions if InScribe crashes or if a TID is 

accidentally checked in or re-pooled. 

 

Insert 

– Clinician:  Search the Client for available Authors.   

– (Hotkey: Ctrl+Shift+Space) 

– AutoText:  Open the AutoText editing window.  (Hotkey: F10) 

– Problem List:  Insert the problem list, if available, at the cursor.  (Hotkey: 

Ctrl+Alt+I) 

 

 

Edit 

– Patient:  Edit Patient Information  (Hotkey: Ctrl+Alt+E) 

– Append/Unappend:  Append or Unappend this transcription to an existing transcription by 

TID number.  (Hotkey: Ctrl+Shift+A) 

– Problem List:  Open the Problem List editing window.  This feature is infrequently used.  

(Hotkey: Ctrl+Alt+P) 
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Lists 

– Commands:  View a list of available commands for various InScribe panes including 

Carbon Copies, Additional Authenticator, Comment Tags, Comments, and Discrete Data. 

 

 
 

ShadowScribe 

These options are only available when editing ShadowScribe or 

structured documents. 

– Add Section:  Add a new Section Heading after the currently 

selected section.  (Hotkey: Ctrl+Alt+H) 

– Add Sub-Section:  Add a new Sub-Section after the currently 

selected section.  (Hotkey: Ctrl+Alt+J) 

– Move Section Up:  Re-order the currently selected Section 

above the previous Section.  (Hotkey: Ctrl+Alt+, ) 

– Move Section and Sub-Sections Up:  Re-order the currently 

selected Section and all child Sub-Sections up above the 

previous Section.  (Hotkey: Alt+Shift+, ) 

– Move Section Down:  Re-order the currently selected Section 

below the following Section.                      (Hotkey: Ctrl+Alt+.) 

– Move Section and Sub-Sections Down:  Re-order the currently 

selected Section and all child Sub-Sections below the following 

Section.  (Hotkey: Alt+Shift+.) 

– Delete Section:  Delete the selected Section heading.  The 

contents of the deleted section will be added to the prior Section.  (Hotkey: Ctrl+Shift+\) 

– Delete Section and Contents:  Delete the selected Section heading and the entire contents of the deleted Section.  

(Hotkey: Alt+Shift+\) 

– Section Properties:  Edit the Title and Section Code.  (Hotkey: Ctrl+F6) 

– Make Sub-Section Section:  Promote a Sub-Section to Section status.  (Hotkey: Ctrl+,) 

– Make Section Sub-Section:  Demote a Section to Sub-Section status.  (Hotkey: Ctrl+.) 
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Format Tab and Editing Window 

The buttons available in the Editing Window are duplicated in the Format Tab for users who choose to hide the Editor bar.  

Those functions commonly associated with standard text editors are found on this tab, and allow users to organize the 

document, add tables, lists, and other common document features. 

 

Transcription Functions 

– Cut:  Copy the selected text to the clipboard, but remove it from the editing window.  (Hotkey: Ctrl+X) 

– Copy:  Copy the selected text to the clipboard and leave the text in the editing window.  (Hotkey: Ctrl+C) 

– Paste:  Paste selected text from the clipboard at the cursor in the editing window.  (Hotkey: Ctrl+V) 

– Undo:  Undo the last action taken, or last text typed.  (Hotkey: Ctrl+Z) 

– Redo:  Retake the last action, or replace text that was removed with the “Undo” function.               (Hotkey: Ctrl+Y) 

– Find:  Search for keywords in the transcription text.  (Hotkey: Ctrl+Shift+F) 

– Replace:  Search for a keyword string and replace it with a different string of characters.                (Hotkey: 

Ctrl+Shift+H) 

– Remove Content After Cursor:  Delete all text after the cursor.  (Hotkey: Ctrl+Shift+Delete) 

– Select All:  Highlight all text in the transcription body.  (Hotkey: Ctrl+A) 

– Toggle Case:  Toggle text case between sentence case, upper case and lower case.  (Hotkey: Ctrl+Alt+U) 

– Delete Left:  Delete the word to the left of the cursor.  (Hotkey: Ctrl+Backspace) 

– Delete Right:  Delete the word to the right of the cursor.  (Hotkey: Ctrl+Delete) 

– Bold:  Begin transcribing text with Bold formatting, or change selected text to bold.  (Hotkey: Ctrl+B) 

– Italic:  Begin transcribing text with Italic formatting, or change selected text to italic.  (Hotkey: Ctrl+I) 

– Underline:  Begin transcribing text with Underlined formatting, or change selected text to underline.  (Hotkey: Ctrl+U) 

– Remove Formatting:  Remove all formatting tags from selected text. 

– Strikethrough:  Begin transcribing text with Strikethrough formatting or change selected text to strikethrough. 

– Super Script:  Begin transcribing text with superscript formatting or change selected text to superscript. 

– Subscript:  Begin transcribing text with subscript formatting or change selected text to subscript. 

– Open in Word:  Open the transcription in Microsoft Word (available for unstructured documents). 

– Align Left:  Align transcription text to the left.  (Hotkey: Ctrl+Alt+L) 
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– Align Center:  Align transcription text centered.  (Hotkey: Ctrl+Alt+C) 

– Align Right:  Align transcription text to the right.  (Hotkey: Ctrl+Alt+R) 

– Align Justified:  Align transcription text with both the left and right margins.  (Hotkey: Ctrl+Alt+F) 

– Indent:  Indent transcription text to the right.  (Hotkey: Ctrl+Shift+M) 

– Unindent:  Unindent transcription text to the left. 

– Page Break:  Insert a manual page break. 

– Show Glyphs:  Show formatting tags. 

– Numbered List:  Insert a numbered or ordered list. 

– Bulleted List:  Insert a bulleted or unordered list.  (Hotkey: Ctrl+Alt+V) 

– Horizontal Line:  Insert a page width horizontal line. 

Table Functions 

– Insert 

o New Table:  Opens the table wizard and inserts the table selected at the cursor. 

o Insert Row Before:  Add a new row above the row the cursor is currently positioned in. 

o Insert Row After:  Add a new row below the row the cursor is currently positioned in.      (Hotkey: 

Alt+Shift+I) 

o Insert Column Before:  Insert a column to the left of the column the cursor is positioned in. 

o Insert Column After:  Insert a column to the right of the column the cursor is positioned in. 

o Insert Cell Before:  Insert a single cell to the left of the cursor position. 

o Insert Cell After:  Insert a single cell to the right of the cursor position. 

– Delete 

o Delete Table:  Delete the entire table and contents. 

o Delete Row:  Delete the Row and contents the cursor is positioned in.  (Hotkey: Alt+Shift+D) 

o Delete Column:  Delete the Column and contents the cursor is positioned in. 

o Delete Cell:  Delete the single cell the cursor is positioned in. 

– Properties 

o Table Properties:  Access properties that affect the entire table. 

o Cell Properties:  Access properties settings that affect the cell the cursor is positioned in. 
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– Merge  

o Merge Cells:  Merge selected cells into one cell. 

o Merge Cell Right:  Merge the currently selected cell with the cell to the right. 

o Merge Cell Left:  Merge the currently selected cell with the cell to the left. 

– Split Cells:  Split the selected cell into two equal cells. 

View Menu 

View information about Transcription Production and change the appearance of InScribe. 

 

View Menu Functions 

– Log:  Display the log of completed transcriptions.  The log is for informational use only.  The actual line count may 

change based on transcriptions in QA, which will not be reflected in this log.  (Hotkey: Ctrl+L) 

o Log For:  Define the date range to search 

completed transcriptions.   

o Client:  Leave the client field blank to 

include all clients in the results or search for 

a specific client. 

o Date Type:  Search by Date Transcribed or 

Date Delivered. 

o Search:  Initiate the search using the selected parameters. 

o Include PHI:  Include confidential Patient Health Information on the report. 

o Print:  Print a copy of the Transcription Log. 

o Save:  Save an electronic copy of the Transcription Log. 

o OK:  Close the transcription log. 

– Work Pool:  Display a list of Transcriptions available for the MT currently logged into.    (Hotkey: Ctrl+Shift+P)  

o Transcription ID:  The unique job identifying 

number. 

o Client:  The hospital or facility where the 

Transcription originated. 

o Clinician:  The author who dictated the job. 
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o Doc Type:  The work type the dictation was created with. 

o Location:  The location the dictation was created with. 

o Priority:  The priority level assigned to the dictation.  Lower numbers indicate higher priority jobs.  By 

default, standard priority dictations are assigned a priority of 4, and STAT dictations are assigned a priority 

of 2. 

o Date Received:  The date the system received the dictation from the Author. 

o Refresh:  Refresh the list to check for new arrivals. 

o Print:  Generate a paper copy of the Pool contents. 

o Close:  Close the Work Pool Window. 

– QA Feedback:  View Feedback for transcriptions reviewed in QA.  (Hotkey: Ctrl+Alt+Q) 

– MT Notes:  View notes or instructions from the Transcription Company regarding 

the selected dictation.  MT notes can include tips and information regarding the 

production of the transcriptions. 

 

 

 

– Shortcuts:  View a list of all hotkeys available in 

InScribe.  (Hotkey: Ctrl+Shift+S) 
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– Character Map:  Open the character map for special characters. 

 

 

 

 

 

 

– Count Lines:  Perform an ad hoc line count.  (Hotkey: Ctrl+T) 

– Configure Foot Pedal:  Configure a three button USB foot pedal for use with 

InScribe.  Note that not all foot pedals are supported. 

– Show/Hide Toolbars:  Tool bars lit up in Orange will be displayed in the InScribe production window.  De-select the 

toolbars to hide them. 

o Editor:  This toolbar contains the editing functions that are available in the Format Tab. 

o Demographics:  This toolbar contains functions to search for patient demographics. 

o Ratings:  This toolbar is used when creating QA feedback. 

o Lists:  These toolbars control Associate, Additional Authenticators, Comment Tags, and Comment 

functions. 

o Status Bar:  Displays MT Pool and Feedback counts and InScribe activity statuses. 

– Reset Panel Widths:  Resizes all panels to their default size and position in InScribe. 

– Maximize Editor:  Hide the Demographics, Associates, Additional Authenticator, and Comment panes to enlarge the 

viewable area of the Transcription Editor.  (Hotkey: Ctrl+Tab) 

– Comment:  Toggle to display the comments list. 

– Show Discrete Data:  Toggle to display the Discrete Data list.  Some document templates define fields that are 

specifically named by your transcription company. This allows the text used to replace that field to be referenced by a 

field later in the document, or by an interface. The Discrete Data window allows you to see what fields have been 

identified and named, and what values have been associated with each field. Please note that this feature is rarely 

used. 

 



 

 

    

    

26 

eScription One 
 

 January 28, 2020 

 

© 2020 Nuance Communications, Inc. All rights reserved. 

Zoom Settings 

Zoom allows the apparent size of the text to be adjusted for visibility without altering the actual text size on 

the finished document.  Select the desired zoom setting from the drop-down menu, or use the Zoom In and 

Zoom Out buttons to select incrementally. 

–  Increase the apparent size of the text. 

–  Decrease the apparent size of the text. 

 

 

 

Jump Functions 

Use the Jump Functions to quickly navigate to different Panes in InScribe.  (Hotkey: Alt+J)  Once the Jump process is 

enabled, InScribe will prompt with letter keys until the cursor is in the desired position. 

  



 

 

    

    

27 

eScription One 
 

 January 28, 2020 

 

© 2020 Nuance Communications, Inc. All rights reserved. 

Advanced Table Functions 

Advanced Table functions allow for control over the size and appearance of a table. 

Table Properties 

Table Properties affect the size and appearance of the entire table.  To access the table 

properties, place the cursor in any cell belonging to the table and press the table properties 

button. 

– Width:  The percentage of the width of the page the table occupies. 

– Rows:  Number of Rows in the Table.  This option is only available during table creation. 

– Columns:  Number of Columns in the Table.  This option is only available during table creating. 

– Alignment:  The alignment of the text in the table.  Options are Left, Right, 

and Center. 

– Cell Spacing:  The amount of space between individual cells. 

– Cell Padding:  The amount of space between the text and the cell walls. 

– Border Size:  The thickness of the Cell Borders.  Set width to “0” to hide 

Cell Borders. 

– Border Color:  The color of the Cell Borders. 

– Background Color:  The color of the Cell Background. 

Cell Properties 

Cell Properties affect the size and appearance of individual cells.  Some cell properties also 

affect the entire column or row.  To access the cell properties, place the cursor in the cell and 

press the cell properties button. 

– Width:  The percentage of the table width the selected column will consume. 

– Height:  The percentage of the table height the 

selected row will consume. 

– Horizontal Alignment:  The alignment of the text 

inside the cell.  Options are Left, Right, Center, and 

Justify.  “Not Set” takes the properties of the table. 

– Vertical Alignment:  The alignment of the text inside 

the Cell.  Options are Top, Center, and Bottom.  “Not 

Set” takes the properties of the table. 

– Word Wrap:  Set if text wider than the width of the cell can occupy additional lines. 

– Rows Span:  Indicates the number of rows the selected cell will take up. 

– Columns Span:  Indicates the number of columns the selected cell will take up. 

– Cell Type:  Options are Header and Data. 

– Border Color:  Color of the individual cell border. 
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– Background Color:  Color of the individual cell background. 

Options 

Open the Options from the File Menu.  The options change how InScribe behaves and allows the 

Transcriptionist to customize the workspace to optimize production.  

 

 

 

 

 

 

 

General 

– Startup Options 

o Download Dictations on Startup:  Deselecting this option will prevent InScribe from automatically 

requesting a dictation upon login. 

o Hide Available Upgrades:  InScribe will not prompt to update when an update is available. 

– Account Options 

o Change Password:  Change the password used to log 

into the current InScribe account. 

– Benchmark KB 

o User Name:  The login ID assigned by Benchmark. 

o Password:  The password for the Benchmark ID. 

o Register with Benchmark KB:  A link for new Benchmark 

KB users. 

– Language:  Currently InScribe is supported in English and Swedish. 

Prompts 

– Job Completion 

o Prompt to Mark for QA:  Options are Always, When In Question, When in Question and Unmarked, and 

Never. 
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o Prompt to Mark for QA when Comments or Comment Tags Exist:  Toggle to Mark for QA based upon 

Comments and Comment Tags. 

– Application Close 

o Show Shutdown Confirmation:  Enables a Shutdown 

Confirmation popup to prevent accidental log off. 

 

– Notifications 

o Prompt When High Priority Job Received:  Display a 

notification if a higher priority (STAT) dictation is downloaded 

to the queue. 

o Prompt When Unselected Job is Removed From Your 

Pool:  Display a notification if a dictation is removed from your 

downloaded queue by the Transcription Manager or automatic 

check-in. 

o Prompt When Queue is Empty and New Work is Available:  Display a notification if no dictations are 

downloaded and work is added to the pool. 

o Prompt When Clinician Field Changes:  Display a notification if the Author fields is updated. 

o Prompt When Appointment Date is After Dictation Date:  Display a notification if the Appointment date is 

later than the Dictation Date. 

o Prompt When Dictation Has Not Been Played Within [ ] Seconds:  Display a notification if the entire 

audio file has not been listened to. 

Playback 

Playback Options control how InScribe’s audio player performs. 

– Control Functions 

o Continue Playback After Rewind or Fast Forward:  Activate this option and the player will continue 

playback after performing Rewind and Fast Forward.  Otherwise the player will pause. 

o Separate Play and Pause Functions:  Enable for foot pedals that need to be held down to continue 

playback. 

o Remember Volume and Playback Rate by Clinician:  Enable to allow InScribe to automatically adjust 

Volume and Playback rate to the last used settings per Author. 

– Time Adjustments 

o Rewind [ ] Seconds: Control the increment that InScribe Rewinds per button press. 

o Fast Forward [ ] Seconds:  Control the increment that InScribe Fast Forwards per button press. 

o Pause [ ] Seconds:  Control the increment that InScribe automatically Rewinds when the dictation playback 

is paused then resumed. 
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– Shadow Scribe Playback 

o Attach Voice Cursor on Play:  Attach the Voice Cursor to the Editing Cursor when the dictation is played. 

o Attach Voice Cursor on Rewind and Fast Forward:  Attach the Voice Cursor to the Editing Cursor after 

Fast Forward and Rewind actions are performed. 

o Attach Voice Cursor on Jump to Index:  Attach Voice Cursor to the Editing Cursor after Jump to Index 

action is performed. 

o Change Voice Cursor Color:  Change the Color of the Voice Cursor to suit user preference. 

Editing 

– Auto Saving 

o Automatically Save Job Every [ ] minutes:  Control the frequency that InScribe will create a save file for 

the selected transcription.  Increase the time to increase computer performance.  Decrease time to perform 

a greater number of backups. 

– User Interface 

o Demographics Highlighter Color:  Change the color of the label text in the Info Pane. 

o List Document Types by Description:  Enable to list Document Types by their descriptions instead of their 

names. 

o Resize List Panels on Focus:  Reset the size of List Panels to their default. 

o Hide Pool Count:  Hide the number of Dictations in the Transcription Pool displayed in the status bar at the 

bottom of InScribe. 

– Patient and Appointment Options 

o Search for Appointment When Dictation Loads at Transcription Level:  Automatically search for an 

appointment if patient information is attached to the dictation when it is loaded at the standard transcription 

level. 

o Search for Appointment When Dictation Loads at QA levels:  Automatically search for an appointment if 

patient information is attached to the dictation when it is loaded at any QA level. 

o Show Single Patient When Not an Exact Match:  Show a patient listing when the result is a single patient, 

but is not an exact match.  Otherwise, the patient information will automatically import. 

o Show Single Appointments:  Show the Appointment Search window even if only one appointment option 

is available for the patient.  Otherwise the appointment information will automatically import. 

o Automatically Load the First Appointment:  Automatically load the most recent appointment, prior to or 

equal to today’s date, for the patient.  Otherwise, the Appointment Search window will display all available 

appointments. 

o Automatically Select Single Patient From Clinician Listing:  Automatically import patient information if 

only one patient is available for the Author for the selected appointment date. 

– AutoText 

o Automatically Expand AutoText:  Enable the use of the AutoText word expansion feature. 
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o Jump to Next Bracket After AutoText:  Enable and InScribe will automatically jump to the next [field] in the 

document.  Otherwise use the Fields command to jump to the next field.  (Hotkey:  F1) 

▪ Set Cursor Position to Start of Document After AutoText With Brackets:  InScribe will begin 
searching for [fields] at the start of the document after the last [field] has been populated.  

o Show AutoText List in Comments:  Add a dropdown list to select from AutoText 

entries marked for use as a Canned Comment in the Comments list. 

▪ Use All AutoText as Canned Comments:  Enable to display all AutoText entries 
in the dropdown list in Comments. 

o Use Double Space After Sentence:  InScribe will enforce two spaces after sentence punctuation. 

– Navigation 

o Ctrl+Left Moves to the Beginning of the Prior Word:  Enable this functionality.  Ctrl+Left will move the 

cursor to the end of the prior word if this feature is not enabled. 

o Ctrl+Right Moves to the Beginning of the Next Word:  Enable this functionality.  Ctrl+Right will move the 

cursor to the end of the next word if this feature is not enabled. 

– Templates 

o Get Document Template When the Location is Changed:  InScribe will 

prompt to load a new Document Template upon Location change.  Note that if 

the transcription contains text you will be prompted to choose to overwrite the 

existing text with the new template text, insert the new template text at the 

cursor, or keep the existing transcription text without loading the new template 

text.   

o Automatically Fill Template Fields:  Allow InScribe to automatically populate 

any [field] entries that it has data for.  For example, if Date of Birth is entered 

into the Info Pane, InScribe will automatically calculate the answer for the 

[Age] field or can populate the [Birthdate] data field within the transcription 

text. 

▪ Options are Always, Never, and Prompt. 

▪ On the right is a list of [Fields] the InScribe is capable of populating/calculating. 
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Foot Pedals 

Foot Pedals are used by InScribe to control the Play, Pause, Fast 

Forward, and Rewind playback functions of the dictation, freeing up the 

typists’ hands from those tasks.  If InScribe is open and a foot pedal is 

plugged in, InScribe will prompt the user to configure the foot pedal.  

The foot pedal configuration screen can also be opened via the File 

Menu, then Options, then Foot Pedals.  

– Status:  The status window displays a list of all connected foot 

pedals.  A check in the box of the “configured” column indicates that 

the device has been configured and will work with InScribe. 

– Foot pedals that are un-plugged from the computer will be 

remembered and will not have to be reconfigured. 

– Foot Pedal Configuration Wizard:  Press to launch the Foot Pedal 

Configuration Wizard. 

 

Configuration Wizard 

– Start the wizard by either plugging in a USB foot pedal, or by selecting the 

Configuration button. 

 

 

 

 

 

 

 

 

 

– Press and Release the Play Pedal 
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– Press and Release the Rewind Pedal 

 

 

 

 

 

 

– Press and Release the Fast Forward Pedal 

 

 

 

 

 

 

– Configuration Complete 

 

 

 

 

 

Spelling 

Control Spellcheck and Dictionary options. 

– Configuration 

o Check Spelling as You Type:  Allow InScribe to display the red line underneath misspelled words as you 

type. 

– Correction Options 

o Ignore Words in ALL CAPS 

o Ignore Domain Names (Web Addresses, etc.) 

o Ignore mIxeD CaSE 

o Ignore Words with Digits (Hello1) 
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o Ignore Numbers (12345) 

o Ignore Capitalized Words (First Letter Caps) 

o Split Hyphenated Words for Spelling (auto-text) 

o Split Contracted Words for Spelling (couldn’t) 

o Allow Accented Caps 

o Allow Possessives on Words (patient’s) 

o Report Uncapitalized Words (canada) 

o Report Doubled Words (the the) 

o Report mIxeD CaSE Words 

o Report Words with Digits (Hello2) 

o Suggest Phonetic Words 

o Suggest Typographical Words 

o Case Sensitive (Treat canada and Canada differently) 

o Check Word Parts (dumptruckdriver would be correct) 

o Capitalize First Letter of Sentence As You Type 

o Reset Options:  Reset spelling options back to default. 

 

– Dictionaries:  Press the Custom Dictionaries button to choose which dictionaries will be used.  Dictionaries on the right 

side of the Custom Dictionaries window are available for use.  Dictionaries on the left side are currently active. 

o Compiled Dictionaries:  Pre-made dictionaries that include Standard English and British dictionaries.  

InScribe does not include medical dictionaries, but Benchmark KB can be enabled to include Stedman’s 

Medical Dictionary.   See section 3.1 for more information.   

o User Dictionaries:  Dictionaries that contain words that are added by the user. 

Shortcut Keys 

– Action Keys:  Customize the actions performed by the Action Keys F1 through F12. 

o Reset Actions:  Reset the Action Keys to their default settings. 

– Options 

o Disable Shortcuts for Re-Pool and Invalidate:  Disable the Shortcuts. 

o Shortcuts:  Choose the Shortcut configuration. 

▪ Use Modified Shortcuts:  This is the default option and has been optimized for InScribe version 6.  
This is also the shortcut set used in this manual. 
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▪ Use Classic Shortcuts:  Use the original Shortcuts from prior versions of the software. 

▪ Use ASR Enhanced Shortcuts:  Use a shortcut configuration optimized for use with ShadowScribe 
editing.  (Voice Recognition QA) 

Advanced 

– Shortcuts 

o Use Global Function Keys:  Allow the Action Keys (F1 through F12) and other (Hotkeys) to be active even 

when InScribe is not the primary active program in Microsoft Windows. 

– Prompts 

o Automatically Check for New Dictations Every [ ] Minutes:  Enable InScribe to check for available 

dictations at the specified interval. 

o Display JavaScript Errors:  For troubleshooting purposes, display error message for InScribe. 

– Playback 

o Audio Player 

▪ InScribe:  Use the default InScribe player. 

▪ Other:  Use an alternate media player currently installed on your machine. 

o Audio Player Path:  The file path to an alternate media player; only enabled when Other is selected for the 

Audio Player. 

o InScribe Wave Player: 

▪ Automatic 

▪ WASAPI 

▪ WaveOut 
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– Data 

o Remove Save Folders:  This option will remove all prior “Save” 

folders under this username.  By default, InScribe removes old 

folders each time you log in, but saves the last two weeks of 

transcription data.  This option will clear all old data. 

o Backup and Restore Personal Files 

▪ Backup to Set:  Choose the Backup options to save your 
AutoText and User Dictionary to a copied location on your 
computer, which you can use to switch between sets or simply 
have a backup copy. 

▪ Restore from Set: Restore a previous backup of your AutoText 
and User Dictionary files. 

▪ Backup to Location:  Options to specify where you want to 
save a backup of your AutoText and User Dictionary, which you 
can use to keep a backup on a separate disk, or to move to 
another computer. 

▪ Restore from Location: Options to retrieve a prior backup of 
your AutoText and User Dictionary files. 

 

 

AutoText 

AutoText is InScribe’s built in Word Expander.  Word expansion can be as simple as expanding a few characters into a 

longer word or phrase, or as much as entire templates complete with Tables and Ordered Lists.  All of the formatting 

options that are available in the standard editing window are available in the AutoText editing window. 

Adding and Removing Entries 

On the left side of the AutoText window is a list of all current expansions. 

– The green  button creates a new entry.  The name entered here will be the short version 

of the expansion.  Note that InScribe will gray out the “OK” button if the name entered has 

invalid characters or is already in use. 

 

– The  Save button stores changes made to the selected entry 

 

 

– The  Delete button removes the selected AutoText entry.  Deleted entries can be 

recovered from backup files. 
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– The Find box is a keyword search, and will return results for both the short name and 

the expansion fields.  The  button initiates a search and the  clears the contents 

of the search box. 

 

Quick Add Feature 

Use the Quick Add boxes to quickly add new AutoText entry.  Enter the short form on the left, and the long form on the 

right.  Press the  button to add and save the entry.  This feature is ideal for quickly adding short expansions, but is not 

suited for large amounts of text and advanced formatting like tables and lists. 

 

 

AutoText Editing  

All of the formatting functions available in the standard editing window are 

available in the AutoText editing window.  A detailed explanation of these 

functions is available in Section 2.13.  In addition to the standard formatting 

options there are two new radial menu options. 

– Use as AutoText:  This entry is used in the main editing window. 

– Use as Canned Comment:  This entry is used in the comments pane, but can 

also be used in the editing window. 

It is possible under the Options Editing screen to allow standard AutoText entries 

in the Comments section. 

Fields and Functions 

Fields and Functions found in your AutoText creator are advanced template creating functions.  Using Fields and 

Functions are comprehensively covered in a document found here: https://www.escription-one.com/Software/InScribe 

How to use Template Fields and Functions 

  

https://www.escription-one.com/Software/InScribe
https://www.escription-one.com/Software/Download?fileName=Template%2520Fields%2520Use%2520Guide%252020170608.1.docx
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Rating a Transcription in InScribe   

QA Ratings & Feedback allows the QA staff to record errors and leave feedback for the prior MT while editing the 

transcription. Each time a transcription passes through QA, the QA staff is able to rate the quality of the previous 

transcriptionist. The ratings and comments applied by a QA1 staff member will be visible to the original Transcriptionist; 

the ratings and comments applied by a QA2 staff member will be visible to the QA1 who worked on this document, and so 

on. 

Your Transcription Company can determine if these ratings will affect your overall Quality Score, and thus your pay rate 

for this transcription. Your company might also choose to utilize this feature to simply provide feedback on the quality of 

your work, without influencing your pay rate. 

Rating Process 

If the QA Ratings & Feedback feature has been 

configured and enabled by the transcription 

company, the QA staff will see the Ratings tab in 

InScribe.  

The Ratings panel shares the same window as the 

Demographics panel. Click on the “Ratings” tab.             

(Hotkey: Ctrl+R)  

 

 

 

In the example, the word “work” is misspelled 

in the first sentence. The process to correct 

this and add an English Word Misspelling 

error is: 

1. In the Editor panel, delete “wrk” and 

type “work”.  Jump to the Ratings 

Tab. 

2. Press E to select English Word 

Misspelling. 

3. Press Enter to add an Error 

Identification marker. 

4. Press Enter to jump to the 

Comment area. 

5. Type your comment and press 

Enter to jump to the Editor panel. 

The cursor returns the same location 

it was in before you added the error. 
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Notes: 

– Shortcut keys are assigned by transcription company management when creating the Rating Program.  

– The same shortcut key may be assigned to more than one Rating. In our example, W is the shortcut key for Medical 

Word Misuse in the Critical Category and for Medical Word Misuse in the Major Category.  

o Pressing W once moves to the first Rating.  

o Pressing W twice moves to the second Rating.  

o If W is pressed a third time, it moves back to the first Rating. 

– Comments are not required. After identifying a new error press Enter a second time to bypass the comment and return 

to the transcription body. 

– To correct the misspelling place the cursor between “w” and “r” of “wrk” and type “o”. 

– Return to the Demographic panel by clicking on the Info tab at the bottom.  (Hotkey: Alt+I) 

– A time index is created to mark the dictation at the time the error was created. This index will be available for playback 

to the person who receives your feedback. 

Let QA Decide / Feedback Only 

The transcription company will determine whether or not the Ratings feature will 

influence the Quality Score, and thus change the pay rate of its transcriptionists. 

QA staff can be given the ability to make this decision on a per-transcription 

basis. At the bottom of the Rating window is a checkbox for “Feedback only (not 

graded)” that is enabled depending on the company’s Ratings settings.  

– If Ratings will not influence the Quality Score, this option is turned ON, and QA 

cannot change the setting. This option will simply provide feedback to the 

person whose work you are reviewing. 

– If Ratings will influence the Quality Score, this option is turned OFF and QA 

cannot change the setting. 

– The company can also decide to allow the QA staff to enable this option. Doing so causes this transcription to be 

ignored by the Quality Score, and will not affect the transcriptionist’s pay. By default, this checkbox is not selected when 

a document is sent to QA.  Select “Feedback only (not graded)” for minor changes that should not affect transcription 

pay rate. 

Reviewing Feedback 

When new feedback is available, a link will appear at the bottom of 

InScribe upon login.  Click the link to open the QA Feedback summary 

window.  Feedback is also accessed via the View Menu and pressing 

the button to view QA feedback.  (Hotkey: Ctrl+Alt+Q) 
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Navigating the Feedback List 

 

– Sort:  Click on any column title to sort feedback items by that column.  Click once to sort in ascending order, twice to 

sort in descending order. 

– Filter:  Use the drop-down menu boxes under any column header to filter feedback to show only transcriptions 

containing that value.  Use this feature to view a particular client, document type, etc. 

– Clear Fields Button:  Reset any selected filters to display any feedback items that might be hidden. 

– Complete Selected:  Remove feedback items by selecting the boxes on the left and clicking Complete Selected. 

– Complete All:  Remove all feedback items. 

– Complete:  Complete an individual feedback item using the “Complete” button in the 

Controls box. 

– Auto Complete Unmodified Feedback:  turn on to skip feedback for transcriptions where 

the body has not been modified by QA.  (Such as those that only go to QA to add an 

associate.) 

Records with Bold text have not been reviewed and are considered “New.”  Records not in bold text have been previously 

opened. 

Transcription Feedback 

View a specific feedback item by clicking on the 

transcription record.  Feedback will open in the 

bottom of the window.  The transcription text 

section defaults to the “QA Version” Tab. 

Identified errors are placed in categories to the 

left.  Expand the error categories to see 

individual errors. 

Click on the Dictation Position value in the Error 

Details to move the playback cursor to that time 

on the audio file.  Addition playback controls 

allow for Play, Pause, Rewind, Fast Forward, 

Move to Beginning, and Move to End.  
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When a specific error code is selected, additional error details appear which include: 

– The type of error code identified. 

– The Category of the error code. 

– The time in the audio file that the error 

was identified. 

– Any additional comments about the error 

added by QA. 

If “Show Changes” is unchecked in the QA 

version tab, clicking on an individual error 

will also highlight in blue any altered text.  

Toggle between the QA finalized version 

and the changes mark-up version with the 

“Show Changes” checkbox. 

 

With “Show Changes” checked, the transcription is marked with QA alterations. 

– Deleted items are highlighted in pink. 

– New items are highlighted in green.   

– Items with formatting changes are highlighted in blue. 

The original transcription text is available under the “My Version” tab. 

The “Client Version” tab displays edits made by the client.  
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Score Card 

A summary of all errors and point deductions is available on the Score Card.  The score card can be printed with the 

available print button. 

 

– Error:  All Error Categories and Error Codes used by the QA Program. 

– Errors Recorded:  The number of occurrences for the Error in this transcription. 

– Points:  The number of points deducted for each occurrence of the error. 

– Deduction:  The number of points deducted for this error type in this transcription.  This is calculated by multiplying 

“Errors Recorded” by “Points.” 

The Final Score for the selected transcription is located at the bottom of the Score Card.  This is calculated based upon 

the number of points deducted against the number of lines in the transcription. 
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The Quick Access Toolbar 

The Quick Access Toolbar is located in the top left corner of the InScribe Window above the ribbon menus.  By default it 

has buttons to Save the transcription, and to Stop Downloads.  Toolbar options are found by right-clicking on any icon in 

the Ribbon Menu, or on the Quick Access Toolbar itself. 

 

– Add to Quick Access Toolbar:  This option is available when clicking on icons in the Ribbon menu.  If the item is 

already present on the Toolbar, this option will be grayed out.  This will add the selected action to the Toolbar. 

– Remove from Quick Access Toolbar:  This 

option is available when clicking on icons in the 

Toolbar.  This will remove the selected action 

from the Toolbar. 

– Show Quick Access Toolbar above/below the 

Ribbon:  Toggle where the Toolbar is displayed. 

– Minimize the Ribbon:  Hide the Ribbon Menu 

icons. 

 

 

 

 

 

Help Menu 

The help menu contains troubleshooting tools and links to articles that provide information to users experiencing difficulty, 

or learning to use the program. 

– Press the  button to open up the InScribe software page 

To access the following features first press the  next to the  button and make a selection. 
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– InScribe website: Also opens the InScribe software page. 

– Knowledge Base:  Open the Nuance Knowledge base for frequently asked questions 

and troubleshooting assistance. 

– About:  Obtain statistics for InScribe and view the current transcription in HTML format.  If 

instructed by a technician, press the “click here” link to upload additional diagnostic data 

in the form of a support ticket. 

– Support:  Contact information to receive technical support. 

– Fix Editor Lag:  Resolve Editor Lag problem.  Note that this is not a permanent fix but should “refresh” the editor to 

where it functions at a normal rate.  (Hotkey:  Alt+Shift+E) 

Spellchecker FAQ 

The suggestions that are shown in the Check Spelling dialog during spell check don't make sense. For example, 
when "accepted" was misspelled, the suggestion was "crepe"? 
This may occur when the Suggestions setting is "Fast but less accurate". Execute spell check from the Emdat editor. 
When a word flags and the Check Spelling dialog displays, click the Options button and change the Suggestions radio 
button to "Slow but accurate". 

I added a word to my User Dictionary and now it's not there? 
View Words from the Spelling and Typing Options dialog does not list the added words in alphabetical order and may give 
the impression that the word is missing. If you don't want to scroll through the entire User Dictionary Word List, you can 
also open the userdic.tlx file with Notepad and use the Find function to verify that a given word is in the dictionary. To do 
this click on the Start button, select All Programs, select Accessories, then Notepad. With Notepad open, select the File 
menu, then Open. When the Open dialog displays, go to the File Types drop down menu and select All Files (*.*), then 
browse to the following folder location: Program Files\Emdat\Spellcheck\vn.n.nnn\An\SSCE\lex. (Note: for the vn.n.nn 
folder, you may have a few of these, double click on the one with the highest number) select userdic.tlx, then click the 
Open button. When the user dictionary opens, click on the Edit menu, then Find to bring up the Find dialog and search for 
your word. 

The suggestions for hyphenated words have an extra space. For example, when "18-year-old" is flagged by spell 
check, the suggestion is "18- year- old"? 
This will occur when "Split Hyphenated Words for Spelling" is unchecked in the Spelling and Typing Options dialog. Check 
the box and suggestions will be provided based on each individual segment. 

Spell check isn't flagging misspelled words. For example, when "Zocor" was misspelled as "Zocorr", it passed 
the spell check? 
This will occur when "Ignore Capitalized Words" is checked in the Spelling and Typing Options dialog. Remove the check 
box and incorrectly spelled capitalized words will be flagged. 

Spell check isn't flagging misspelled words. For example, when "cabinet" was misspelled as "cabnet", it passed 
the spell check? 
This will occur when "Check Word Parts" is checked in the Spelling and Typing Options dialog. Remove the check box 
and spell check will look at the entire word instead of breaking it down into parts. 

I upgraded InScribe and spell check is acting differently. Words which would have flagged before are not and 
words are flagging that didn't use to? 
Spell check has changed and is now looking at each word in context to its surrounding words. This provides for improved 
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reliability and conforms more closely to spell check rules used by popular word processing programs such as Microsoft 
Word. 

I upgraded InScribe and my custom dictionary isn't working? 
The installation program does copy custom dictionaries to the new spell check folder. However, you will still need to Add 
the dictionary from the Spelling and Typing Option dialog. 
 

 

Removing InScribe 

Note: Users on a network may need to contact their system administrators if they do not have the rights to install or 

uninstall software. 

– Click on “Start” and select “Control Panel”. 

– Double click on “Programs and Features” 

or Choose to “Uninstall a Program.” 

– Click on “InScribe”. 

– Click on “Change/Remove”. 

– Click on “Yes” to confirm uninstall. 

– Once uninstallation is complete, click 

“OK”.  
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Support 

Get assistance for InScribe, and all other eScription One applications, here: 

– Phone Support: 1-800-858-0880 

– Support Email: eSOne@nuance.com 

– eScription One software page for downloading InScribe: 

https://www.escription-one.com/Software/InScribe 

 

 

mailto:eSOne@nuance.com
https://www.escription-one.com/Software/InScribe

